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1.  Introduzione 

 
Il presente elaborato ha come obiettivo la progettazione di un sistema meccanico da 

inserire in un macchinario per test dinamici già esistente chiamato “Barra di 

Hopkinson”. 

Prima sarà effettuato uno studio analitico preliminare, poi le verifiche verranno 

perfezionate utilizzando un software agli elementi finiti, in questo caso “ANSYS”. 

Parallelamente ai calcoli è stata eseguita una modellazione 3D dei componenti 

attraverso il software “Solid Edge”. 

Il progetto è stato sviluppato cercando di tenere in considerazione ogni criterio 

tecnologico e funzionale. 

La presente tesi inizia illustrando il funzionamento della classica Barra di Hopkinson 

per poi passare alla discussione del progetto sviluppato, il quale trae origine proprio dal 

bisogno di rispondere a nuovi problemi e far fronte a nuove esigenze emerse durante 

l’uso del dispositivo. 
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2.  Barra di pressione split- Hopkinson 
 

La barra di Hopkinson fu proposta per la prima volta da Bertram Hopkinson nel 1914 

come uno strumento per misurare la propagazione dell'impulso di stress in una barra di 

metallo. Più tardi, nel 1949 Herbert Kolsky perfezionò la tecnica di Hopkinson usando 

due barre Hopkinson in serie, ora conosciute come la barra divisa Hopkinson, per 

misurare lo stress e la deformazione. 

Il campione di materiale è posizionato fra due barre nella barra frazionata di 

Hopkinson: la input bar e la output bar. Il cosiddetto percussore, che solitamente è un 

cannone ad aria compressa, sparerà la strike bar contro la input bar , questo creerà un 

impulso d’urto lungo tale barra.  

 

 

 

 

Una volta che l’onda di tensione raggiunge l’interfaccia barra – provino si verificano 

diverse riflessioni lungo il provino stesso, incrementandone il livello di tensione fino al 

raggiungimento dell’equilibrio delle forze al suo interno. Allo stesso tempo un’onda di 

tensione, avente il medesimo segno dell’onda incidente sull’input bar, si propaga lungo 

la barra di output ed un onda di tensione di segno opposto è riflessa lungo la barra di 

input. 

Due sezioni strumentate con estensimetri, poste al centro della barra di input e di 

output rispettivamente, convertono le deformazioni sulle barre suddette in segnali 

elettrici analogici proporzionali alle deformazioni cui le barre sono soggette durante la 

trasmissione delle onde di tensione elastiche. I segnali forniti dagli strain gauges 

Figura 1-Split Hopkinson Pressure Bar 
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vengono registrati ed analizzati allo scopo di ottenere la caratteristica tensione-

deformazione del materiale testato.  

La barra di Hopkinson installata in Università possiede un sistema innovativo che 

consente di produrre l’onda di pressione pre-caricando la strike bar grazie all’utilizzo di 

un incastro a rilascio rapido. 

 

L’estremità della striker bar è filettata e su di essa vengono avvitati 2 nottolini di acciaio 

con interposto un elemento sacrificale di spessore variabile. L’elemento sacrificale è 

serrato da un manicotto sull’albero che trasferisce il moto prodotto da un martinetto 

meccanico che permette di pretensionare la striker bar; quest’ultima viene in questo 

caso denominata ‘barra pretensionata’. Il martinetto tira indietro, facendola traslare, la 

barra pretensionata fino a provocare la rottura dell’elemento sacrificale. Ora, l’altra 

estremità della barra pretensionata è collegata alla input bar tramite un nottolino 

filettato che impegna le due estremità delle stesse. 

 

 

 
 

Figura 2- Barra di Hopkinson con porzione di Input Bar precaricata 

Figura 3-Martinetto precaricatore 
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I principali vantaggi dell’utilizzo di tale metodo sono una lunghezza delle onde di 

tensione facilmente regolabile ed una più uniforme distribuzione degli sforzi attraverso 

la sezione retta. 

Ora l’Università sta studiando un modo alternativo per la trasmissione delle forze 

attraverso molle che andranno inserite nei supporti assiali oggetto di tale tesi. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 4-Barra di Hopkinson 
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3. Progetto dei supporti assiali 

3.1. Approccio al problema 

 

Il problema principale è il dimensionamento della sezione tubolare dei supporti perché 

devono garantire una piccola freccia nonostante il peso delle molle inserite su di essi. 

 

 

Nella figura che precede è possibile vedere l’approccio semplificativo iniziale usato per 

minimizzare le sezioni tubolari. Il diametro esterno è vincolato invece dimensioni delle 

molle. 

Il passo successivo è stato il calcolo delle bullonature: per il supporto più lungo si è 

utilizzata una geometria dell’ancoraggio al telaio, molto simile allo schema iniziale; per 

il supporto più corto il calcolo ha presentato maggiori difficoltà, specificatamente nel 

rispondere in modo adeguato alla forza orizzontale che si scaricherà durante il test. 

 

 

 

 

 

 

Figura 5-Schema strutturale dei supporti 
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3.2. Software CAD: Solid Edge 

 

Come supporto alla progettazione è stato utilizzato un Software CAD, nello specifico 

Solid Edge. Attraverso la realizzazione di un modello 3D si è riuscito a studiare meglio 

gli ingombri ed installare tale supporto nella trave usata per fare i test. 

La motivazione principale che ci ha spinto ad usare Solid Edge è stata il voler fare 

successivamente una simulazione tramite analisi FEM. Il software CAD utilizzato 

realizza un modello 3D compatibile con il programma di simulazione e modificabile al 

suo interno. 

Il supporto realizzato è formato solo da superfici solide, quindi da estrusioni di superfici 

piane, in più il modello è stato diviso in diversi corpi poi uniti da cordoni di saldatura per 

avvicinarci alla pratica reale. 

 

 

Figura 6-Modello 3D di Barra di Hopkinson con barra pretensionata da un martinetto 
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3.3. Progettazione 

 

3.3.1. Misure di base per la fase di calcolo 

 

In questo paragrafo verranno esposti tutti i dati iniziali del problema. 

 

Il peso delle molle è stato semplificato come dei carichi distribuiti ortogonalmente alla 

trave, ad essi è stato aggiunto il peso lineare del corpo tubolare. 

Le masse delle molle sono:  

 M1=50 kg                  ●  L1= 400 mm               

 M2=85 kg                  ●  L2= 600 mm 

 M3=30 kg                  ●  L3= 280 mm 

 H=200 mm 

Quindi la formula generica del carico distribuito è:  

  

Dove ρ= 7850 kg/m3   e    g= 9,81 m/s2 . 

Il modulo di Young dell’acciaio è: E= 2,1*1011 N/m2 

Figura 7-Schema strutturale dei supporti 

Figura 8-sezione trasversale del 
corpo tubolare 
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“A” indica, invece, indica l’area della corona circolare in funzione dello spessore “s” con 

diametro esterno di 145 mm per il supporto più lungo e di 124 mm per il più corto. 

     

 

Altre grandezze che andremo a definire sono il momento di Inerzia della corona 

circolare e quello della sezione del pilastro di altezza H. 

 𝐼(𝑠) =  𝐷 −  (𝐷 − 2 𝑠)                                                     

𝐼 =       dove b=40 mm e h=60 mm                                                                                            

 

 
 
 
 
 

3.3.2. Dimensionamento dei singoli componenti 

 

3.3.2.1.       Primo supporto 

 

Per prima cosa dimensioneremo lo spessore della sezione tubolare del supporto più 

lungo. Per farlo andremo a risolvere la linea elastica di tale struttura e la 

minimizzeremo in funzione di “s”. 

 

 

 

Figura 9-Sezione pilastro base 
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Per farlo andremo a scomporre questa struttura in un pilastro ed una trave. 

La freccia totale sarà formata da due spostamenti verticali ed uno orizzontale:  

 

a) Spostamento verticale dovuto alla freccia della singola trave in punta; 

b) Spostamento verticale dovuto alla rotazione rigida della trave; 

c) Spostamento orizzontale dovuto alla freccia del singolo pilastro in punta; 

 

 

 

 a) 

Ora andremo a scrivere l’equazione del momento 

con i sistema di riferimento riportato qui a fianco. 

Figura 10-Schema strutturale primo supporto 

Figura 11-Diviosione in sottostrutture del primo supporto 

Figura 12-Sistema di riferimento 
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𝑀(𝑧) = 𝑀 (𝑧) = −𝑃 𝑧2   ,   0 ≤ 𝑧 ≤ 𝐿𝑀 (𝑧) = −𝑃  𝐿 𝑧 − 𝐿2 − 𝑃2 (𝑧 − 𝐿 )    ,    𝐿 < 𝑧 ≤ 𝐿 + 𝐿  

 

Essendo una struttura isostatica possiamo utilizzare l’equazione della linea elastica 

flessione del secondo ordine          𝑣 (𝑧) = − ( )( ) ( )   
 

𝑣 (𝑧) = 𝑣 (𝑧) = − 𝑀 (𝑧)𝐸 𝐼   ,   0 ≤ 𝑧 ≤ 𝐿𝑣 (𝑧) = − 𝑀 (𝑧)𝐸 𝐼   ,   𝐿 < 𝑧 ≤ 𝐿 + 𝐿  

 

Integrando rispetto a z per 2 volte : 

 

𝑣 (𝑧) = ⎩⎪⎨
⎪⎧ 𝑣 (𝑧) = 𝑃𝐸𝐼 𝑧6 + 𝐶   ,     0 ≤ 𝑧 ≤ 𝐿

𝑣 (𝑧) = 𝑃 𝐿𝐸𝐼 𝑧 − 𝐿22 + 𝑃2𝐸𝐼 (𝑧 − 𝐿 )3 + 𝐾   ,    𝐿 < 𝑧 ≤ 𝐿 + 𝐿  

 

𝑣(𝑧) = ⎩⎪⎨
⎪⎧ 𝑣 (𝑧) = 𝑃𝐸𝐼 𝑧24 + 𝐶 𝑧 + 𝐶   ,    0 ≤ 𝑧 ≤ 𝐿

𝑣 (𝑧) = 𝑃 𝐿𝐸𝐼 𝑧 − 𝐿26 + 𝑃2𝐸𝐼 (𝑧 − 𝐿 )12 + 𝐾  𝑧 + 𝐾  , 𝐿 < 𝑧 ≤ 𝐿 + 𝐿  

 

 

 

 



11 
 
 
 

Condizioni al contorno: 

 

⎩⎨
⎧𝑣 (𝐿 + 𝐿 ) = 0𝑣 (𝐿 + 𝐿 ) = 0𝑣 (𝐿 ) = 𝑣 (𝐿 )𝑣 (𝐿 ) = 𝑣 (𝐿 )                  

Dalla seconda equazione è possibile ricavare K1 : 

𝐾 = − 𝑃 𝐿2𝐸𝐼  𝐿 + 𝐿2 − 𝑃 𝐿6𝐸𝐼  

 

Di conseguenza possiamo trovare K2 dalla prima equazione: 

𝐾 = 𝑃 𝐿2𝐸𝐼  𝐿 + 𝐿2 (𝐿 + 𝐿 ) + 𝑃 𝐿6𝐸𝐼 (𝐿 + 𝐿 ) − 𝑃 𝐿6𝐸𝐼 𝐿 + 𝐿2 − 𝑃 𝐿24𝐸𝐼 
 

Conoscendo già K1 possiamo calcolarci C1 dalla quarta equazione: 𝑃 𝐿8𝐸𝐼 + 𝐾 = 𝑃 𝐿6𝐸𝐼 + 𝐶 →  𝐶 = 𝐾 − 𝑃 𝐿24𝐸𝐼 

 

Ora dalla terza equazione possiamo ricavare C2: 𝑃 𝐿48𝐸𝐼 + 𝐾 𝐿 + 𝐾 = 𝑃 𝑙24𝐸𝐼 + 𝐾 − 𝑃 𝐿24𝐸𝐼 𝐿 + 𝐶  

 

→ 𝐶 = 𝑃 𝐿48𝐸𝐼 + 𝐾  

La freccia all’estremità della trave si avrà per 𝑓 (𝑠) = 𝑣(0) quindi 𝑓 (𝑠) = 𝐶  ,il tutto sarà 

in funzione dello spessore “s” : 
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𝑓 (𝑠) = 𝑃 (𝑠)𝐸 𝐼(𝑠) 𝐿48 + 𝐿2 𝐿 + 𝐿2 (𝐿 + 𝐿 ) − 𝐿6 𝐿 + 𝐿2 + 𝑃 (𝑠)𝐸 𝐼(𝑠) 𝐿6 (𝐿 + 𝐿 ) − 𝐿24  

 

Per semplicità di calcolo, chiameremo X ed Y i termini dentro le parentesi quadre 

attribuiremo loro un valore numerico: 

𝑓 (𝑠) = ( ) ( ) 𝑋 + ( ) ( ) 𝑌 ,    𝑋 = 0,1154       [𝑚 ]𝑌 = 9,6 ∗ 10  [𝑚 ] 
 

b) 

𝑀 = 𝑃 + 𝑃 𝐿 𝐿 +  

Per trovare la rotazione dovremo fermarci a 𝑣 (𝑧) 

 

 
 
 

 
Il carico verticale N può essere trascurato nel calcolo del momento poiché il suo 

braccio è veramente piccolo. 

 𝑣 (𝑧) = 𝑀𝐸𝐼 𝑧 + 𝐶  

 
Per 𝑧 = 𝐻 si ha 𝑣’ = 0 quindi  𝐶 = −  
 
Il termine 𝑣’(𝑧) rappresenta la tangente dell’angolo, nel nostro caso stiamo trattando 

angoli infinitesimali quindi 𝑣 (𝑧) = 𝑡𝑎𝑛𝜗 ≈ 𝜗 

L’angolo di rotazione della trave si avrà per 𝑧 = 0: 

Figura 13-Schema statico 
pilastro e sistema di riferimento 
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𝑣 (0) = − 𝑀𝐻𝐸𝐼𝑥 → 𝜗 = 𝑀𝐻𝐸𝐼𝑥  

La freccia che ne deriverà all’estremità della trave può essere calcolata come: 

𝑓 (𝑠) = (𝐿 + 𝐿 )𝑠𝑒𝑛𝜗 ≈ (𝐿 + 𝐿 ) 𝑃 (𝑠) 𝐿2 + 𝑃 (𝑠)𝐿 𝐿 + 𝐿2 𝐻𝐸𝐼  

 

c)  

 

mantenendo lo stesso sistema di riferimento e 

trascurando nuovamente il carico verticale N andremo 

a calcolare lo spostamento orizzontale in punta del 

pilastro. 

 
 

 
 𝑣(𝑧) = 𝑀2𝐸𝐼𝑥 𝑧2 + 𝐶1𝑧 + 𝐶2 

C1  l’avevamo calcolata in precedenza: 𝐶 = −  

Mentre per C2 basterà imporre 𝑣(𝐻) = 0:    𝑀𝐻2𝐸𝐼 − 𝑀𝐻𝐸𝐼 + 𝐶 = 0    →     𝐶 = 𝑀𝐻2𝐸𝐼  

La freccia in punta del pilastro si avrà per 𝑧 = 0 : 𝑣(0) = 𝐶 =  

𝑓 (𝑠) = 𝑃 (𝑠) 𝐿2 + 𝑃 (𝑠)𝐿 𝐿 + 𝐿2 𝐻2𝐸𝐼  

 

 

Figura 14- Schema statico pilastro e 
sistema di riferimento 
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Ora possiamo calcolarci lo spostamento totale in punta del supporto più lungo: 𝑓 (𝑠) = [𝑓 (𝑠) + 𝑓 (𝑠)] + [𝑓 (𝑠)] = 

= 𝑃 (𝑠)𝐸 𝐼(𝑠) 𝑋 + 𝑃 (𝑠)𝐸 𝐼(𝑠) 𝑌 + (𝐿 + 𝐿 ) 𝑃 (𝑠) 𝐿2 + 𝑃 (𝑠)𝐿 𝐿 + 𝐿2 𝐻𝐸𝐼 + 𝑃 (𝑠) 𝐿2 + 𝑃 (𝑠)𝐿 𝐿 + 𝐿2 𝐻2𝐸𝐼  

 

Per procedere in maniera analitica bisognerebbe andare a derivare la precedente 

equazione rispetto ad “s” e poi porla uguale a zero. Considerando l’elevato grado 

dell’equazione, la risoluzione a mano risulterebbe impraticabile, per tale motivo si è 

deciso di adottare un foglio di calcolo nello specifico Excel. 

Di seguito andremo ad analizzare la procedura su Excel per minimizzare una funzione 

e disegnarne il grafico. 

 

Creata questa semplice tabella andremo ad inserire un valore generico “s” per poi 

calcolarci gli altri elementi in funzione di esso. 

 

Ora per minimizzare la funzione ftot andremo ad utilizzare lo strumento di analisi di 

simulazione denominato “risolutore” su tale casella. 

Figura 15-Tabella per calcolo della freccia minima 

Figura 16- Tabella per calcolo della freccia minima 
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Il vantaggio di questo strumento è quello di poter inserire l’intervallo della variabile nel 

quale trovare il minimo della nostra funzione. 

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Risolvendo otterremo un minimo per 𝑠 ≈ 5,5 𝑚𝑚 
 

 

Quindi avremo un diametro interno della corona di 134 mm. 

 

 

Figura 17-Interfaccia del comando “risolutore” 

Figura 18-Tabella con risultati finali 
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Usando le stesse colonne e calcolando i valori per “s” da 1 a 73 mm possiamo 

costruirci anche il grafico della ftot.  

 

 

 
 
 
 
 
 
 

 

 

L’ultimo step consiste nel dimensionare le bullonature del supporto, di seguito vengono 

riportate le misure del basamento. 

Utilizzeremo per il calcolo il modello di flangia cedevole. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

 

Figura 19-Grafico della freccia totale al variare dello spessore 

Figura 21-Schema piastra base del primo supporto Figura 20-Schema flangia cedevole 
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𝑀 = 774,61   𝑁 𝑚                         𝐹 , = , ∗ ∗∗( ) = 5029,94  𝑁 

 
Andando a favore della sicurezza possiamo trascurare la forza N. 

La forza scaricata nei bulloni è molto bassa per cui verificherà anche 

scegliendo una classe di resistenza 4.6. 

 𝜎 = 240  𝑀𝑃𝑎         quindi      𝐴 = , = 20,96   𝑚𝑚         
 
Scegliendo un M 14 4.6 staremo più che sicuri.  

Di seguito verranno portate alcune misure per la realizzazione del modello 3D.        

 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 22-Schema 
statico pilastro 
primo supporto 

Figura 23-Schema quotato primo supporto 
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Figura 24-Rappresentazione 3D del primo supporto 
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3.3.2.2.       Secondo supporto 

 
 
In maniera analoga al primo supporto procederemo al calcolo dello spessore della 

corona circolare del secondo. 

Per ora possiamo omettere la forza orizzontale la quale sarà 

fondamentale per il calcolo delle bullonature di ancoraggio. 

I contributi alla freccia totale saranno sempre gli stessi ma li 

riporteremo qui di seguito per completezza. 

 
 
 
 

a) Spostamento verticale dovuto alla freccia della singola trave in punta; 

b) Spostamento verticale dovuto alla rotazione rigida della trave; 

c) Spostamento orizzontale dovuto alla freccia del singolo pilastro in punta; 

 

 

 
 
 
 
 
 

 
 
 
a) 

 𝑀(𝑧) = −𝑃 𝑧2  
 

Figura 25-Schema 
strutturale secondo 

supporto 

Figura 26-Divisione in sottostrutture del secondo supporto 

Figura 27-Sistema di riferimento 
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Passando all’equazione della linea elastica flessione del secondo ordine e integrando 

due volte:           𝑣 (𝑧) = − ( )                   𝑣 (𝑧) = + 𝐶                𝑣(𝑧) = + 𝐶 𝑧 + 𝐶  
 
Ora andremo a ricavare le due costanti mettendo a sistema le condizioni al contorno, 

questa volta come si può vedere è tutto più semplice poiché abbiamo solo un carico 

distribuito. 

Condizioni al contorno: 
 
 
 𝑣 (𝐿 ) = 0𝑣(𝐿 ) = 0             

𝐶 = −𝐶 =  

 
 

Il primo contributo si avrà 𝑧 = 0  quindi   𝑓 (𝑠) = 𝑣(0) = 𝐶  

Scrivendolo in maniera esplicita: 

𝑓 (𝑠) = 𝑃 (𝑠) 𝐿8𝐸𝐼 
 

 

b) 
 

Anche in questo caso la componente N può essere 

trascurata. 

𝑀 = 𝑃 𝐿2  

𝑣 (𝑧) = 𝑀𝐸𝐼𝑥 𝑧 + 𝐶1 

 
 

Figura 28-schema statico e 
sistema di riferimento 
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C1 possiamo ricavarlo imponendo 𝑣 (𝐻) = 0  quindi 𝐶 = −  

Ricordando le approssimazioni usate per il primo supporto possiamo subito calcolarci 

l’angolo di rotazione:  𝜗 = |𝑣′(0)| = 𝑃3𝐿34𝐻2𝐸𝐼𝑥  

𝑓 (𝑠) = 𝐿 𝑠𝑒𝑛𝜗 ≈ 𝐿 𝑃 (𝑠) 𝐿2 𝐻𝐸𝐼  

 

c) 
 

Usando il sistema di riferimento precedente calcoleremo in ultimo la freccia orizzontale 

del pilastro: 

𝑣(𝑧) = 𝑧 + 𝐶 𝑧 + 𝐶         con   𝐶 = −  

Mentre per calcolare C2 basterà imporre 𝑣(𝐻) = 0  

 𝑀𝐻2𝐸𝐼 − 𝑀𝐻𝐸𝐼 + 𝐶 = 0    →     𝐶 = 𝑀𝐻2𝐸𝐼  

La freccia in punta del pilastro si avrà per 𝑧 = 0 : 𝑣(0) = 𝐶 =  

𝑓 (𝑠) = 𝑃 (𝑠) 𝐿2 𝐻2𝐸𝐼  

 

Ora è possibile calcolare lo spostamento totale in punta del secondo supporto: 

𝑓 (𝑠) = [𝑓 (𝑠) + 𝑓 (𝑠)] + [𝑓 (𝑠)] = 𝑃3(𝑠) 𝐿348𝐸𝐼 + 𝑃3(𝑠) 𝐿322 𝐻𝐸𝐼𝑥 + 𝑃3(𝑠) 𝐿324 𝐻2𝐸𝐼𝑥  
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Per minimizzare la freccia in funzione di “s” il procedimento è identico al primo 

supporto. 

Quindi creeremo un foglio Excel con l’unica differenza che questa volta è presente un 

solo carico distribuito. 

Come si può vedere cambierà anche l’intervallo su cui trovare il valore di “s” che 

minimizza la freccia, questo è dovuto al fatto che il diametro interno della molla 

montata sul secondo supporto è più piccolo rispetto al primo. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

Il diametro interno quindi può essere approssimato a 117 mm. 

 

 

 

 

Figura 29- Interfaccia del comando “risolutore” 

Figura 30 -Tabella con risultati finali 
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Andando a completare la tabella con valori di “s” da 1 a 62 mm è possibile costruire il 

seguente grafico. 

 
                        Figura 31- Grafico della freccia totale al variare dello spessore 

 

 

Per ultimo rimane da dimensionare le bullonature, ma in questo caso è molto 

importante considerare la forza orizzontale di 38040 N. 

Tale forza ci ha obbligato a cambiare la geometria del sistema per ridurre la freccia 

totale e per diminuire la forza di taglio scaricata sulle bullonature del basamento. 

Anche il corpo tubolare è stato ancorato con 4 bulloni alla parete del basamento quindi 

andranno calcolati anche quest’ultimi. 

La parete verticale su cui è montato il corpo tubolare è posizionata all’estremità della 

piastra base quindi il momento generato dal carico P3 andrà a comprimere la base sulla 

trave. La forza orizzontale T, oltre ad essere una forza a taglio sulle bullonature 

genererà anche un momento che si scaricherà su di esse.      

Innanzitutto dimensioneremo i 6 bulloni di ancoraggio del basamento sulla trave IPE. 
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Le forze in gioco saranno quindi: 
 𝑇 =  39240 𝑁              𝑀 = 𝑇 ∗ 𝐻 − 𝑃 = 7802,8 𝑁 𝑚 
 
Utilizzando come per il primo supporto la condizione di flangia cedevole possiamo 

calcolare la forza scaricata sui bulloni. 

Prenderemo come riferimento i bulloni posizionati nella parte più critica cioè 

all’estremità opposta della parate verticale. 

𝐹 , = 7802,8 ∗ 10 ∗ (0,098 + 0,097 + 0,097)2 ∗ 0,098 + 2 ∗ (0,098 + 0,097) + 2 ∗ (0,098 + 0,097 + 0,097) = 8572,38 𝑁 

Ipotizzando una classe di resistenza 12.9 abbiamo: 𝑓 , = 1200 ∗ 0,7 = 840 𝑁𝑚𝑚  

𝑁 = 0,8 ∗ 840 ∗ 𝐴     carico di serraggio in funzione dell’area resistente 𝑉 , =  1 −         

Figura 32-Schema piastra base secondo supporto 
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Dove: 

   𝜇 è il coefficiente d’attrito pari a 0,15 𝛾  è il coefficiente di sicurezza di 1,25 𝑁  è la forza di espansioni che coincide con la nostra 𝐹 ,   

La 𝑁 ,  si avrà per 𝑉 , = = 6540 𝑁 

  𝑁 , = 𝑁 +  𝑉 , = 8572,38 + ,,  6540 = 63072,38 𝑁 

𝐴 , = ,, ∗ ≈ 94 𝑚𝑚   

Quindi sceglieremo una M 14 12.9. 

 
 
 
Ora passeremo a dimensionare le bullonature di ancoraggio del corpo tubolare alla 
parete verticale. 
 
 
 

 

 

 

𝑀 = 𝑃 𝐿2 = 45,2 𝑁 𝑚 

𝑇 = 𝑃 𝐿 = 322,87 𝑁 
 

Figura 33-Schema quotato piastra con corpo tubolare 
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𝐹 , = 45,2 ∗ 10 ∗ 1354 ∗ 135 = 83,7 𝑁 
 𝑉 , = 𝜇 𝑁𝛾 1 − 𝑁𝑁  

 per 𝑉 , = = 80,72 𝑁 si ha 𝑁 , : 

𝑁 , = 𝑁 + 𝛾𝜇  𝑉 , = 83,7 + 1,250,15  80,72 = 756,37 𝑁 

Ipotizzando una classe 4.6 abbiamo 𝑓 , = 240  ,quindi : 

𝐴 , = 756,370,8 ∗ 240 ≈ 4 𝑚𝑚  

Quindi la scelta cadrebbe in dei bulloni M 12 4.6, ma per comodità di 

approvvigionamento dei componenti, si useranno comunque bulloni 12.9. 

Come si diceva in precedenza, la geometria del secondo supporto è stata migliorata 

per garantire migliori prestazioni. Di seguito vengono portate delle misure di base per la 

realizzazione del pezzo. 

 

Figura 34-Vista frontale e laterale secondo supporto senza corpo tubolare 
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Figura 35-Rappresentazione 3D del secondo supporto 
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3.4. Assieme finale 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Collocando i supporti finali nella trave 

IPE di destinazione, è stato possibile 

valutare meglio gli ingombri. 

Nel 3D non è ancora inserito il sistema 

di pretensionamento, poiché non sono 

ancora stati definiti le parti di 

collegamento con esso. 
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4. Realizzazione di un modello FEM del supporto e   confronto 
dei risultati analitici 

 
 

 
Poiché i calcoli fatti a mano non possono prevedere ogni tipo di comportamento della 

struttura, è stato necessario l’utilizzo di un software di simulazione basato sul metodo 

agi elementi finiti. 

 

 

4.1. Metodo degli elementi finiti 
 
 
Il metodo degli elementi finiti, consiste nella discretizzazione di un assegnato dominio 

in elementi fra loro connessi in un numero finito di punti, vertici degli elementi chiamati 

nodi. Gli spostamenti nodali saranno le incognite del nostro problema e tutte le 

grandezze in questione dipenderanno da essi. 

Gli elementi formano così una griglia reticolare definita mediante il termine 

anglosassone mesh. 

All’interno di ciascun elemento, si assume che l’andamento della grandezza oggetto di 

studio possa essere espressa mediante una funzione continua, detta funzione forma. 

La scelta di tali funzioni, come pure del tipo di mesh con cui discretizzare il dominio è di 

fondamentale importanza per la convergenza della soluzione. 

In termini generali, tale metodo permette di risolvere in maniera approssimata problemi 

descritti da equazioni differenziali alle derivate parziali riducendole in equazioni 

algebriche. 

 

 



30 
 
 
 

 

4.2. Ansys Workbench 18.1 
 

Il programma utilizzato per la tesi in oggetto è Ansys 18.1, in particolare la piattaforma 

Workbench dotata di un’interfaccia più intuitiva. 

Ansys è dotato di numerosi ambienti di simulazione e in questo caso è stato utilizzato 

Static Structural poiché ci consente di eseguire analisi statiche di sollecitazioni su 

strutture meccaniche. 

Il procedimento di lavoro per lo studio di un problema strutturale agli elementi finiti si 

articola in tre fasi successive:  

• Fase di pre-processing: dove viene generato il modello strutturale, definito il 

materiale e generata la mesh;  

• Fase di solving: è la fase di risoluzione del modello strutturale e viene gestita dal 

programma in base alle istruzioni per la risoluzione numerica predefinite dall’utente;  

• Fase di post-processing: è la fase dove vengono valutati ed analizzati i risultati e 

elaborati dal risolutore numerico. 

La fase di scelta del materiale verrà omessa poiché si è tenuto l’acciaio di default del 

programma tenendo in considerazione le diverse classi di resistenza durante la 

verifica. 

 

4.3. Definizione della geometria 
 

Una volta realizzato il modello 3D su Solid Edge è possibile importarlo su Ansys 

attraverso il modulo Geometry; all’interno di esso si aprirà un software CAD chiamato 

Spaceclaim in cui è possibile disegnare e modificare modelli 3D. 
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Nel primo supporto, è stato inserito un piano trasversale al corpo tubolare per dividerlo 

in due corpi soggetti a carichi distribuiti diversi, che poi andranno riuniti selezionandoli 

contemporaneamente tasto destro > Move to new component > Share topology: 

Merge. 

Lo stesso procedimento dovrà essere applicato ai bulloni del primo e del secondo 

supporto dividendoli nel punto in cui inizia il dado perché successivamente il 

pretensionamento andrà ad essere applicato nella parte di gambo tar testa e bullone. 

Workbench riconosce automaticamente le parti di cui è composto l’assieme 

contrassegnandole con colori differenti come è possibile vedere in figura. 

 

 

 

 

 

 

 

 

 

 

 

4.4. Definizione dei contatti tra superfici 
 
 
Il passo successivo è definire i contatti tra le varie superfici nello spazio Model. 

Tutti i contatti che si possono definire sono: 

Figura 37-Geometria 3D secondo supporto in Spaceclaim Figura 36-Geometria 3D primo supporto in Spaceclaim 
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 Bonded: vincolo relativo sia normale (bilaterale) che tangenziale 

 No separation: vincolo relativo solo normale (bilaterale), ma non tangenziale 

 Frictionless: vincolo relativo solo normale (unilaterale), ma non tangenziale 

 Rough: vincolo relativo sia normale (unilaterale) che tangenziale 

 Frictional: vincolo relativo sia normale (unilaterale) sia tangenziale, fino al limite 

di attrito. Successivo comportamento di attrito dinamico. 

I primi due sono lineari, ciò vuol dire che il problema è risolvibile tramite l’inversione di 

una matrice; gli altri tipi di contatto sono non lineari, quindi il programma trova la 

soluzione per tentativi con un maggior dispendio di tempo. 

Il programma riconosce automaticamente i contatti tra le superfici del modello 

importato, ma li imposta di default in bonded. Quest’ultimi, quindi, andranno ispezionati 

e cambiati uno ad uno e tale processo semplificato dall’interfaccia grafica che colora le 

due superfici a contatto come si può vedere di seguito.  

 

 

 

 

 

 

 

 

 

Nel nostro caso abbiamo utilizzato il primo e l’ultimo tipo di contatto: l’uso del primo è 

legittimato dal fatto che simula bene le superfici saldate; l’ultimo, per le superfici che 

presentano solo attrito. Il contatto bonded è stato utilizzato anche per l’incastro filettato 

del dado nel gambo della vite. 

Figura 38-Definizione dei contatti 
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Nel primo supporto sono state definite 13 connessioni, mentre nel secondo 39; per 

entrambi sono stati realizzati fori con gioco, quindi non vi è nessuna connessione tra il 

gambo del bullone ed il foro. 

 

 

 

4.5. Generazione della mesh 
 
 

Una delle fasi cruciali nella realizzazione di un modello FEM è la creazione della mesh, 

in quanto da essa dipende la qualità della simulazione. In Ansys Workbench 

,nell’ambiente Static Structural, viene generata automaticamente la mesh essendo in 

grado di riconoscere la geometria dei vari corpi; tuttavia, volendo condurre un’analisi 

più precisa, andranno cambiati alcuni parametri.  

Le principali caratteristiche della mesh sono la forma degli elementi e la loro 

dimensione, in generale più si crea una fitta discretizzazione del pezzo e più l’analisi 

sarà accurata, ma allo stesso tempo si necessiterà di un computer potente perché 

aumenterà il numero di equazioni.  

La tipologia di mesh usata nel nostro caso è ibrida cioè formata da elementi con 

geometrie differenti (triangolari, quadrangolari). 

La dimensione utilizza per la mesh è di 12 mm, mentre per le bullonature è stata 

portata a 6 mm attivando il comando Mesh > Insert > Sizing, poi selezionando i corpi in 

oggetto e digitando la dimensione scelta su Element size. Sempre per i bulloni, inoltre, 

è stata cambiata la geometria in cubetti Sizing > Insert > Method > MultiZone, tale 

forma è la più regolare e garantisce un minor tasso di errore.  
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Il primo supporto è stato discretizzato in 30948 elementini, il secondo in 22098 con 

rispettivamente 121238 e 110889 nodi. 

 

 

 

 

 

 

 

 

 

 

4.6. Definizione dei vincoli 
 

 

I vincoli da noi imposti rappresentano condizioni al contorno delle equazioni 

differenziali che il programma andrà a risolvere. 

Figura 41-Mesh secondo supporto 

Figura 40-Mesh primo supporto 

Figura 39-Mesh Multizone 
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L’unico vincolo usato per entrambi i supporti è Fixed Support che rappresenta un 

incastro perfetto, per inserirlo occorre seguire il seguente comando: Analysis Settings > 

Insert > Fixed Support.  

Inizialmente, per verificare la correttezza dei calcoli eseguiti a mano si è deciso di 

applicare il vincolo sopra descritto direttamente alla piastra base senza inserire le varie 

bullonature come è illustrato qui a fianco, al fine di eseguire una rapida analisi 

preliminare.  

Successivamente per avvicinarci ancor più al caso reale è stata disegnata una parte 

della trave IPE su cui è montato il nostro supporto e applicato il vincolo fixed support su 

di essa. Il modello a questo punto è stato completato anche delle rispettive bullonature. 

Il modello finale è rappresentato qui di seguito. 

Figura 45-Definizione dei vincoli con geometria finale primo 
supporto 

Figura 44- Definizione dei vincoli con geometria finale secondo 
supporto 

Figura 42-Definizione vincoli con geometria iniziale primo supporto 

Figura 43-Definizione vincoli con geometria 
iniziale secondo supporto 
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4.7. Definizione dei carichi 
 
 
Ora andremo a definire i carichi di progetto dei supporti, nel farlo divideremo la 

trattazione per il primo e secondo supporto, poiché faremo per quest’ultimo alcune 

complicazioni. 

  

 
 
 
 

4.7.1.   Primo supporto 
 
 
Nel primo supporto bisognava inserire tre tipologie di carico: 

a) Forza di gravità 

b) Carichi distribuiti 

c) Pretensionamento bulloni 

 

a)  In Ansys è già presente un comando che simula la forza di gravità, dunque è stato 

sufficiente procedere come qui di seguito riportato: Analysis Settings > Insert > 

Standard Heart Gravity.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 46-Standard Heart Gravity 
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b) Quelli che noi abbiamo approssimato a carichi distribuiti, sono in realtà dei carichi 

tridimensionali generati dal peso delle molle inserite sui sopporti. In Ansys un comando 

che rappresenta bene questo tipo di  situazione è Analysis Settings > Insert > Bearing 

Load, in quanto il nostro problema è analogo al carico in un cuscinetto. 

Per la corretta esecuzione del comando va inserito il modulo della forza quindi       𝐹1 =490,5 𝑁 ed 𝐹2 = 833,85 𝑁. 

 

 

 

 

 

 

 

 

 

c) Anche in questo caso Ansys è munito di un comando per questa tipologia di carico 

Analysis Settings > Insert > Bolt Pretension , per completare bisognerà inserire la forza 

di pretensionamento di 22000 N. 

 

 

 

 

 

 

 

 

Figura 47-Bearing load 

Figura 48-Bolt Pretension 
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4.7.2.   Secondo supporto 
 

Nel secondo supporto, a differenza del primo, abbiamo fatto in modo che le forze in 

gioco non si inserissero tutte nello stesso istante temporale: Analysis Settings > 

Number of steps:2. La durata dei due steps è di un secondo ciascuno per un totale di 

due secondi, nei quali i carichi si divideranno nel seguente modo: 

 

   1o step                                                               2o step 

a) Pretensionamento dei bulloni                            b) Forza di gravità 

                                                                                c) Carico distribuito 

                                                                                d) Forza orizzontale 

 
 

 
a) Per inserire il pretensionamento basterà attivare Bolt pretension come nel primo 

supporto; i bulloni della piastra base avranno un precarico di 77280 N, mentre quelli 

di ancoraggio del corpo tubolare alla parete verticale di 16000 N. Nel secondo step 

andranno bloccati Bolt Pretension> Definition > Define by: Lock. Le stesse operazioni 

potevano essere eseguite su tabular data come nell’immagine che segue.  

 

 

 

 

 

 

b) La forza di gravità questa volta non è stata aggiunta con il comando apposito poiché 

verrebbe inserita automaticamente nel primo step. Questo non avviene perché nella 

Figura 49-Tabular Data Bolt Pretension 
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fase di montaggio l’operatore deve sorreggere il corpo tubolare per poterlo montare.Per 

far fronte a questo inconveniente trattiamo la forza di gravità come una normale 

accelerazione Analysis Settings > Insert > Acceleration con l’accortezza di inserirla 

nella direzione positiva dell’asse z.  

 

 

 

c)  Il carico distribuito si inserisce come nel primo supporto attraverso il comando Bearing 

Load con modulo di 294,3 N.  

 

 

 

 

 

d) Per inserire la forza applicata in una superficie il comando da eseguire è Analysis 

Settings > Insert > Force con modulo di 39240 N.  

 
 
 
 
 
 

 

Figura 51- Tabular Data Acceleration 

Figura 50- Forza di gravità secondo supporto 

Figura 52-Tabular Data Bearing Load 

Figura 53-Tabular Data Forca 
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4.8. Analisi dei risultati 
 
Completata anche la definizione dei carichi è possibile analizzare i risultati mediante 

elaborazioni grafiche, nello specifico abbiamo analizzato le deformazioni totali e 

direzionali e le tensioni interne. 

 

4.8.1.    Analisi deformazioni 
 
 
I comandi usati sono Solution > Insert > Total Deformation e Directional Deformation, 

attraverso i quali il programma mostra il 3D del nostro modello con diverse bande di 

colori correlate ai relativi risultati numerici sotto forma di legenda (figura 54-55). 

Grazie all’analisi della deformazione si è deciso di cambiare geometria del secondo 

supporto, dal momento che non soddisfaceva alcuni requisiti. 

È possibile visualizzare la soluzione in altre tipologie di grafiche, ad esempio una che 

rende chiara la deformazione del pezzo è Show Undeformed WireFrame che mostra le 

linee del corpo indeformato (vedi figura 56-57). 

 

 

 

Figura 55-Total Deformation secondo supporto 

Figura 54-Total Deformation primo supporto 
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Derictional deformation invece misura lo spostamento lungo un asse di rifermento e in 

tal caso l’asse z; inoltre, questo strumento ci aiuta a capire a anche la correttezza dei 

calcoli iniziali. 

Nel primo supporto lo spostamento in punta è di 1,92 mm contro 1,19 mm calcolato 

analiticamente mentre per il secondo è di 0,03 mm contro circa 0,02 mm (figura 58-59). 

Questa discrepanza dei risultati, soprattutto per il primo supporto, ci indica che la 

schematizzazione adottata per i calcoli è molto semplificativa rispetto alla geometria 

reale. 

 

Figura 57-Deformata primo supporto 

Figura 56-Deformata secondo supporto 
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4.8.2.    Analisi delle tensioni 

 
 

Per il calcolo delle tensioni abbiamo utilizzato il criterio di Von Mises, Solution > Insert > 

Equivalent Von-Mises Stress. Quest’ultimo è un’criterio di resistenza relativo a materiali 

duttili, isotropi, con uguale resistenza a trazione e a compressione, come l’acciaio nel 

nostro caso. 

Come si può vedere in figura 60, dove sono 

state omesse le bullonature, le tensioni interne 

sono relativamente basse, poiché si considerava 

accettabile fino a 200 MPa. 

 

 
 
 
 
 
 

Figura 58-Directional Deformation secondo supporto 

Figura 59-Directional Deformation primo supporto 

Figura 60-Tensione equivalente secondo supporto 



43 
 
 
 

È interessante osservare le tensioni lungo le saldature che rimangono comunque limitate 
con picchi spora i 200 MPa in zone infinitesimale quindi trascurabili.  
 
 
 
 
 
 
 
 

 

 

 

 

Nel primo supporto, invece, le tensioni interne sono ancor minori dato che non è 

presente alcuna forza orizzontale. Nella figura 62 sono riportati i risultati, sempre 

seguendo il criterio di Von Mises e trascurando le bullonature. 

 

 

Per lo studio degli ancoraggi si è usato un comando a parte: Solution > Insert > Bolt 

Tool > Working Load; questo strumento non dà come risultato l’andamento delle 

tensioni ma delle forze, molto utile nello studio dei bulloni. 

Figura 61-tensione equivalente saldature 

Figura 62-Tensione equivalente primo supporto 
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Assumendo come forza di 77367 N per i bulloni di ancoraggio alla putrella e di 16046 N 

quelli di ancoraggio alla parete verticale, possiamo verificare se rispetta la tensione 

ammissibile. 

 

 

 

 

 

 

 

 

Classe 12.9   →    𝑓𝑘,𝑛 = 840 𝑁𝑚𝑚2          𝜎 = = 673 < 840             
Classe 4.6    →     𝑓𝑘,𝑛 = 240 𝑁𝑚𝑚2            𝜎 = = 191 < 240  

Per quanto riguarda il primo supporto, l’analisi dei bulloni può essere trascurata, 

essendo questi sovradimensionati rispetto al carico in gioco. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 63-Working Load 
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5.   Conclusioni 

 

Nel presente lavoro di tesi sono stati trattati numerosi aspetti della progettazione, 

iniziando con la verifica dei componenti tramite modelli analitici, per poi concludere con 

l’utilizzo dei programmi di simulazione. 

Il modello 3D è stato realizzato subito dopo i calcoli preliminari, in quanto 

indispensabile per portare avanti la simulazione strutturale. 

La simulazione è stata eseguita mediante il metodo degli elementi finiti, utilizzando il 

software ANSYS. I primi risultati ottenuti non sono stati soddisfacenti, pertanto si è 

ritenuto necessario apportare alcune modifiche nella geometria del secondo supporto. 

Questo denota che le semplificazioni utilizzate nel modello analitico di partenza non 

approssimavano bene la geometria reale. 

Il risultato finale si è ottenuto dopo numerosi studi condotti variando i diversi parametri 

in modo opportuno. 
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